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INTRODUCTION 
 
This introductory level course is aimed at those who want to learn word 
processing basics. 
 
Knowledge assumed  
 experience of using a computer, for example keyboard 

familiarity 
 experience of using Windows 
 familiarity with a mouse, icons, loading software and 

click boxes 
 
 
Areas covered  
 creating a document 
 saving and retrieving a document 
 basic editing 
 producing a letter and envelope 
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Document signposts 
 
 
 
Instructions for you to type  
 Bold text 

 
 
 
Shortcuts  
 

 
 
Reminders  
  

 
 

 
 
Notes  
 
 
 
 
Exercises  
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STARTING WORD 2007 
 
 

 Double click the Word 2007 icon on the desktop 
 
or 
 

 Click the Start button (at the bottom left of the screen) 

 Select All Programs 

 Select Microsoft Office 

 Select Microsoft Office Word 2007 
 
A blank document is automatically opened ready for use. 
 
 
SCREEN OVERVIEW 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Insertion point 

Office 
Button 

The 
Ribbon 

Help 

Tabs Title bar 

Status bar 

Scroll 
bar 

Quick Access 
toolbar 
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OFFICE BUTTON 
 
The Office Button is common to Word, Excel, PowerPoint, Access and 
Outlook and provides the basic commands such as open, save and print, 
together with some new ones.    
 
 

 Click the Office Button now 
 
 
The window opens and you see the commands available. 
 

 
 
You also see a list of the most recent documents you have accessed. 
 
Some commands, such as Print, have a  next to them, and this indicates that 
there will be further options to choose from. 
 

 Hover the mouse pointer over each of the commands in turn 
 

 Click away from the window to deselect it 
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QUICK ACCESS TOOLBAR 
 
The Quick Access Toolbar, which is next to the Office Button, is a customisable 
toolbar that contains commands that are independent of the tab currently 
displayed.   
 
 
 
 
 
 
By clicking the toolbar, you can add other commands to it, either from the list 
displayed, or by clicking the More Commands option. 
 

 
You can see that the currently selected commands on the Quick Access Toolbar 
are Save, Undo, and Redo. 
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THE RIBBON 
 
The Ribbon is designed to help you quickly find the command you need to 
complete a task.  The commands are organised in logical groups which are 
collected together under tabs.   
 
As you click on a tab the Ribbon shows you the commands that are grouped 
under that tab. 
 
The tabs you see when you open Word 2007 are not the only ones available;  
some, such as the Picture Tools tab, are shown only when needed. 
 
The picture below shows the Home tab which features, amongst others, 
commands enabling you to specify the font size and style, and also text 
alignment. 
 

 
 
 

 Click each tab now to see the commands available 
 
 
 
STATUS BAR 
 

 Look at the status bar at the bottom of the screen 
 
 
 
 
 
 
 
 
 
 
The status bar indicates the options currently selected. 
 
You can customise the status bar by adding other options such as line number 
and section number.  
 

Word 
count Language Zoom 

Page 
number 

Spelling and 
grammar 

check 

View 
shortcuts 

Zoom 
slider 
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VIEW SHORTCUTS 
 
You use the view shortcuts to select the way that you want to view the 
document. 
 
 
 
 
 
 
 
 
 
 
Print layout 
 
To see how text, graphics, and other elements will be positioned on the printed 
page, use Print layout view.  It is useful for editing headers and footers, for 
adjusting margins, and for working with columns and drawing objects. 
  
 
Full screen reading 
 
This view shows you the full page (hiding the ribbon, title bar and status bar) so 
that you can maximise the space available for reading or commenting on the 
document.   
 
 
Web layout 
 
You use this view when you are creating a web page or document that is viewed 
on the screen.  In Web layout you can see backgrounds, text is wrapped to fit 
the window, and graphics are positioned just as they are in a web browser. 
 
 
Outline 
 
This view shows you the structure of your document and makes it easy to move, 
copy, and reorganise text by dragging headings.  You can collapse a document so 
that you see only the main headings, or you can expand it so that you see all of 
the headings and body text. 
 
 
Draft 
 
Use this view if you want to quickly edit text, but do be aware that certain 
elements, such as headers and footers, will not be visible in this view. 
 

Print 
layout 

Web 
layout 

 
Draft 

Full 
screen 
reading 

Outline 
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HELP 
 
Help is always available.   
 
To see the Help window, either: 
 

 Click the Help button    
 
or  
 

 Press F1 
 
 
There is a list of topics which you can browse through. 

 
Alternatively, you can type a word or phrase in the Search window. 
 

 Type spelling 
 

 Click the  button 
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The results of the search are revealed: 

 
 
The icon next to each entry indicates the type of help that has been found. 
 

 Word help and how-to 

 Word training 

 Word template 
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 Select the first item in the list Check spelling and grammar 
 

 
 
 
There are three options available which are indicated by the blue text and 
arrows. 
 

 Click   
 
You then see further options. 
 

 Point and click on  
 
You are told how to perform the task. 
 

 Close Help by clicking the Close icon  at the top right corner of the dialog 
box 
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OPENING A NEW BLANK DOCUMENT 
 

 Point to the Office Button and click 
 
 

 
 

 Click New 
 
The New Document window opens: 
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TEMPLATES 
 
Every Word document is based on a ‘template’ that determines the basic 
structure of the document.  The New Document window offers a range of 
options, including Blank document (which is based on the Normal template), 
Installed Templates (which are included in Word), and your own templates when 
you have created them. 
 
It is likely that most of your documents will be based on the Normal template.  
This is the one that contains the ‘default’ settings that are available for all 
documents.  A ‘default’ is a value or setting that is automatically selected if you 
do not specify a substitute. 
 

 Click Blank document 
 
A new document is opened. 
 
 
 
To open a new document 
 
Hold the Ctrl key down and press N 
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ENTERING TEXT 
 
You are now ready to start creating a document. 
 
WORD WRAP 
 
All word processing packages use word wrap.  This feature allows you to type 
continuously without having to worry that the text will overflow into the right 
margin of your document.  Word will automatically ‘wrap’ your lines of text to 
keep them within both the left and right margins. 
 
It is very important, therefore, that you do not press the Enter key             
unless you want to create a heading or start a new paragraph. 
   
 

 Type the following text into your new document – any mistakes are 
deliberate, you will correct them later 

 
 
THE MOUSE 
 
The mouse is a warm bloded animal that is insulated from the environment by its 
hairy and waterproof skin. 
 
There are some very famous mice about, I’m sure you have heard of Mickey, Minnie 
and Jerry. 
 
There are six different species of mice living in England, but it is the house mouse 
that is the best known to most of us.  It prefers to live inside, where it is warm and 
there is plenty of food, although some may live outside during the winter months. 
 
The mouse will eat whatever it can find, its favourite food is seeds, but it will enjoy 
any scrap of left-over food – even cheese! 
 
The mouse that lives outside has paler fur and a white belly.  Its most noticeable 
feature is a tail that is slightly shorter than the rest of its body. 
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SPELLING AND GRAMMAR CHECKING 
 
Look at the text that you have just typed and you will notice that, as you type, 
some words are automatically underlined in RED or GREEN.  Don’t worry about 
this – Word is indicating that it thinks you have made a spelling mistake (red 
underlining), or that your use of grammar might be improved (green 
underlining)!    
 
In your text the word ‘bloded’ has been indicated as a spelling mistake.  In this 
instance Word is correct, but this is not always true.  Words are matched against 
a dictionary and, if they are not found, they are underlined in red so that you 
notice and check them.  Proper words such as place names are unlikely to be 
included in the dictionary and so are likely to be shown as a spelling mistake. 
 

 Point to the word ‘bloded’ 

 Display the quick menu by clicking the right mouse button  
 
 

 
 
 
 
 
 
In addition to the quick menu you will also see the mini toolbar, which is 
discussed on page 15. 
 
 

Mini 
toolbar 

Quick 
menu 
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At the top of the menu, there are several suggested spellings to correct the 
word.  You could select one of these and the word in the text would be changed 
accordingly.  However, you will amend the spelling later in the training, so: 

 Point to the bottom of the document and click the left mouse button to hide 
the menu 

 
You can use the quick menu to see suggested amendments to text that is 
underlined in green too. 
 
 
 
MINI TOOLBAR 
 
You have already seen that, when you select text, a miniature semi-transparent 
toolbar is displayed.  This is known as the mini toolbar and you can use it to add 
formatting to your document.    
 

 
 

It offers a selection of commands such as font, alignment, indenting and bullets. 
 
 
 
CLICK AND TYPE 
 
Click and type allows you to insert text in any position on the page.   
 
Reposition the insertion point so that it is two or three lines below the end of 
your document:  
 

 Move the mouse pointer to an appropriate position 

 Double click the left mouse button 

 Type your name 
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SAVING 
 
It is very important that you acquire the habit of regularly saving your 
document, say every 20 minutes or so.  Until you save a document, its contents 
are held in a temporary file.  If you accidentally switch off your computer, or 
there is a power cut, the contents of the temporary file may be partially or 
totally lost.  
 

 Click the Office Button 
 

 Click Save 
 
The Save As dialog box is opened. 
 

 
 
 
Word will, by default, offer you the folder called My Documents, and if you are 
working on your own computer, it’s fine to save your document in this folder.   
 
However, to help you in the future to find documents you’ve stored on the 
computer, it’s better to create a folder specifically for the work you are doing 
so that you can store related documents together.  If you don’t know how to 
create folders, consider attending the ‘Windows File Management’ training 
course.  Alternatively you can access the training guide at 
www.training.dmu.ac.uk – but only from computers within the University. 
 
If you are working on a computer in one of the University computer labs, you 
should be able to save to your own network area.  If you’re not sure how to do 
this, ask the Technician. 
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If you are attending a course in the IT Training Suite: 
 

 Click the drop arrow next to the Save in box and select the folder named 
Word2007GettingStarted 

 

 
 
 
Word has automatically offered a name for the file, but you are going to amend 
it. 
 
In the File name box: 
 

 Type Mouse 
 

 Click Save 
 
 
The document is saved and the filename is displayed on the title bar at the top 
of the screen. 
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NAMING FILES AND NAMING CONVENTIONS 
 
When you save a document you need to give it a name.  To make it easier to find 
it later, you can use a long, descriptive, file name – you are allowed up to 255 
characters in total.   
 
In our examples in this training session, all of the file names we instruct you to 
use are short, but remember that, in a work situation, you need to be able to 
identify files easily, so do give them meaningful names – Report1 may mean 
something to you at the time, but three months later its content will not seem 
so obvious. 
 
Remember, as well, that there are certain characters that you cannot include in 
a file name – these reserved characters are as follows:   
 
 

Character Name 
/ forward slash 
\ back slash 
> greater than 
< less than 
* asterisk 
? question mark 
“ quotation mark 
| pipe symbol 
: colon 

 
 
 
 
 
TO SAVE A FILE 
 
Click the Save button    on the Quick Access Toolbar   
 
or 
 
Hold down the Ctrl key and press S 
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SELECTING (HIGHLIGHTING) TEXT 
 
In the next section you will be editing the document – inserting, deleting, and 
replacing text. 
 
Before you can do this, however, you need to know how to select specific items, 
say a word or a sentence, for example, and there are several ways of selecting 
text using the mouse. 
 
 

 Follow the instructions below to practise selecting 
 
 
DRAGGING 
 
Dragging can be used to select single characters or ‘bits’ of text. 
 

 Point to the place where you want the selection (highlighting) to begin 
 

 Hold down the left mouse button 
 

 Drag the mouse in any direction  
 
When the pointer hits the side or the top/bottom of the screen, the document 
will automatically scroll as the highlighting continues. 
 

 Release the mouse button when you have selected the desired area 
 
 
 
IMPORTANT TO REMEMBER 
 
Take care once you have selected (highlighted) text – if you press any key on the 
keyboard, the text will be deleted.   
 
If this does happen, don’t panic.  Use the UNDO option (explained on page 24). 
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SELECTING ENTIRE WORDS 
 

 Double click (using the left mouse button) anywhere on the word you want to 
select 

 
 
 
SELECTING ENTIRE LINES OF TEXT 
 

 Position the mouse pointer in the left margin 
 

The mouse pointer changes from the I-beam  to a right pointing arrow    
 

 Click the left mouse button   
 
The entire line to the right of where you have clicked will be selected. 
 
To select an additional line: 
 

 Drag the arrow down the document 
 
 
 
SELECTING ENTIRE PARAGRAPHS 
 
There are two ways of selecting entire paragraphs: 
 
 
Paragraph – triple click 
 

 Position the mouse pointer anywhere in the paragraph you wish to select 
 

 Triple click the left mouse button (quickly click three times in succession) 
 
 
Left margin – double click 
 

 Position the mouse pointer in the left margin next to the paragraph you wish 
to select 

 
 Double click the left mouse button 
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SELECTING THE ENTIRE DOCUMENT 
 

 Position the mouse pointer in the left margin 
 
Either 
 

 Hold the Ctrl key down and click the left mouse button once 
 
or 
 

 Treble click in the left margin 
 
 
 
SELECT ALL 
 
Hold down the Ctrl key and press A 
 
 
 
 
 
REMOVING A SELECTION 
 
To remove a selection (highlighting): 
 

 Click anywhere in the document away from the highlighted text 
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EDITING TEXT 
 
INSERTING  
 
To insert text, you position the insertion point where you want the new text to 
go, and start typing. 
 

 Position the insertion point (cursor) at the end of the third paragraph 
ending…. the winter months. 

 
 Press Enter twice 

 
 Type the following new paragraph 

 
The mouse that lives inside is about 10 cm long with a tail of the same length.  It has 
brownish-grey fur on its back with pale-grey fur on its belly and sides. 
 
 
There is a typing error in the first paragraph of the document. 
 

 Position the insertion point between the ‘o’ and the ‘d’ in the word ‘bloded’  
 

 Type o 
 
There is a missing word in the final paragraph. 
 

 Position the insertion point between the words ‘a’ and ‘tail’ in the final 
sentence 

 
 Type the word long 

 
 
 
DELETING 
 
To delete text, position the insertion point immediately after the text to be 
removed, and then use the Backspace key to delete it.   
 

 Position the insertion point at the end of the second paragraph ending …. 
Mickey, Minnie and Jerry. 

 
 Press the Backspace key                until the entire paragraph has been 

deleted.   
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Delete 

IMPORTANT TO REMEMBER 
 
You can also delete text using the        key 
 
To do this you need to position the insertion point immediately before the text 
to be deleted. 
 
 
 
 
DELETING AN ENTIRE WORD 
 
With the insertion point positioned immediately after the text to be deleted: 
 
Hold down the Ctrl key and press the left arrow                 key  
 
With the insertion point positioned immediately before the text to be deleted: 
 
Hold down the Ctrl key and press the Delete key 
 
 
 
 
REPLACING 
 
You replace text by simply typing over it.  
 

 Select the word ‘England’ in the second paragraph 
 

 Type Britain 
 
In the final paragraph 
 

 Select the word ‘shorter’ 
 

 Type longer 
 
 
 
Now have a go on your own 
 

 Insert the following sentence at the end of the first paragraph 
 
It belongs to a group of mammals called rodents. 
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 Delete the dash and the last two words of the fourth paragraph (– even 
cheese) but leave the exclamation mark 

 
 Insert your name again immediately under the last paragraph 

 
 Save the file 

 
 
 
UNDO  
 
As you add to or edit a document, Word records all of your actions and makes 
them available via the Undo button.   
 
If, for example, you delete a word, you can use the Undo button to bring it 
back.  This function is only helpful if you realise reasonably quickly that you 
have made a mistake.  This is because all of your actions from the time you open 
a document until you close it are recorded, and therefore the more editing you 
do to a document, the longer the list of actions which can be undone. 
 

 Click the Undo button     on the Quick Access Toolbar once only    
 
 
Your last action (which was typing your name) has been undone. 
 
If you click the arrow at the side of the Undo button, you are able to view a list 
of all the actions that can be undone. 
  

 
 

 Click away from the box to close it 
 
 
 
IMPORTANT TO REMEMBER 
 
As actions must be undone in sequence, you cannot choose an action from, say, 
the middle of the list and undo it in isolation – all of the actions above it in the 
list must also be undone. 
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Redo 
 
The Redo button works in much the same way as the Undo button.  If, having 
undone an action, you then decide that this was a mistake, you can click the 
Redo button.  
 

 Click the Redo button     on the Quick Access Toolbar 
 
Your name is pasted back into the document. 
 
 
 
Repeat  
 
You can repeat your last action by clicking the Repeat button  on the Quick 
Access Toolbar. 
 
If you can't repeat the last action, the Repeat command changes to Can't 
Repeat. 
 
 
 
 
 
You will notice that you see either the Redo or the Repeat button – the button 
changes depending upon your actions. 
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FIND AND REPLACE 
 
It is possible to automatically find a given word (or phrase), however many times 
it appears throughout a document, and replace it with another word. 
 

 Ensure that the Mouse document is still on the screen 
 
You will have noticed that the word mouse appears several times in this 
document.  For your next task, you are going to find every occurrence of the 
word mouse and change it to the word cat. 
 

 Ensure that the Home tab is displayed on the Ribbon 
 
The Editing commands – Find, Replace, and Select – are located at the right hand 
end of the Home tab. 
 
 
 
 
 

 
 
 

 Click Replace 
 
The Find and Replace dialog box is displayed: 
 

 
 
 
 

Editing 
commands 



Word 2007 Getting Started (030108) 27 ©De Montfort University, IT Training 2008 
 
 

In the Find what: window: 
 

 Type the word mouse  
 

 
 
 
In the Replace with: window: 
 

 Type the word cat  
 

 Click the Replace All button 
 
You will see a dialog box advising how many replacements have been made. 
 

 
 
 

 Click OK 
 

 Click Close 
 

 Look at the changes that have occurred in the document 
 
 
 
If you click the Replace button rather than Replace All, Word searches for and 
highlights the first occurrence of the target word.  If you want to replace it, 
click the Replace button again.  Word then searches for the next occurrence of 
the target word. 
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TO FIND WHOLE WORDS ONLY 
 
The find and replace function in the previous exercise should work without any 
difficulty.   
 
If, however, the exercise was reversed and you were asked to find the word 
‘cat’ and replace it with the word ‘mouse’, you might encounter a few 
problems.   
 
The letters C A T may appear within a number of words (for example,  
compliCATed, dediCATion, conCATenated, CAThode) and could also be used as 
an abbreviation for the word CATalogue.  Therefore if you use this search as it 
stands, every word containing the letters C A T will be found. 
 
To resolve this problem, in the Find and Replace dialog box: 
 

 Click the More button 
 

 Click in the Find whole words only check box 
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Have a go on your own 
 

 Undo the replacements 
 

 Replace the word lives with the word resides 
 

 Undo the replacements 
 

 Save the file 
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SCROLLING 
 
To move quickly through your document, you can use the scroll bars at the side 
and bottom of the screen – see the screen overview diagram on page 3). 
 
Practice now 
 

 Scroll to the bottom of the document 
 

 Scroll to the top of the document 
 

 Scroll to the left and then to the right of the document 
 
 
 
 
QUICKLY MOVING AROUND TEXT 
 
Left/right, word by word 
 
Ctrl key +  or Ctrl +   
 
 
 
End/start of a line 
 
Press   or  
 
 
 
Top/bottom of a paragraph 
 
Ctrl key +  or Ctrl + 
 
 
 
Up/down one screen 
 
Press   or  
 
 
 
Top/bottom of the document 
 
Ctrl key +   or  Ctrl +  
 

  

End Home 

  

Page 
Down 

Page 
Up 

Home End 
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PRINTING 
 
The file you have created should still be open. 
 
 
PRINT PREVIEW 
 
You use the Print Preview option to display each page as it will look when 
printed.   
 
This is particularly useful where you have a multi-page document and you want 
to see where the page breaks fall.  Having previewed the document, you can 
then make any necessary changes before printing it. 
 
 
 
You can force a page break to ensure that a particular section of your document 
starts on a new page. 

 Position the insertion point where you want the new page to begin 

 Select the Insert tab on the Ribbon 
 

 
 
 
 
 
 
From the Pages commands group: 
 

 Select Page Break 
 
 
Alternatively, hold the Ctrl key and press Enter. 
 
 
 

Pages 
commands 
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 Click the Office Button 
 

 Point to Print 
 

 
 
 

 Select Print Preview 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Your document should 
look something like this 
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You will also see the Print Preview contextual tab on the Ribbon. 
 

 
 Click Close Print Preview  

 
 
 
 
IMPORTANT TO REMEMBER 
 
Always SAVE a file BEFORE printing it. 
 

Close Print 
Preview 
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PRINTING OPTIONS 
 
Having previewed your file, you are now ready to print it. 
 

 Click the Office Button 
 

 Point to Print 
 

 Select Print 
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The Print dialog box is displayed. 
 

 
 
 
As you can see, this dialog box offers you a number of options.  The ones 
annotated above are as follows: 
 
1. The printer to be used 
2. The page range to be printed 
3. The number of copies to be printed 
 
 

 Click OK 
 
 
Assuming the printer is switched on your document will now print. 
 
 
  

2 

1 

3 
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TO PRINT A COMPLETE DOCUMENT 
 

 Press the Ctrl key and P 
 
or 
 

 Click the Office Button 
 

 Select Print 
 

 Select Quick Print 
 

 
 
 
Note that, with this option, you do not have the opportunity to specify which 
pages you want to print. 
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CLOSING A DOCUMENT 
 
Once you have finished with a document, it is good practice to close it.  You 
can, of course, have several documents open simultaneously.  
 
If you make any changes to any of the open documents, when you close Word, 
the program will prompt you to save and close each of the documents which 
have been altered but not saved.  
 

 Click the Office Button 
 

 Click Close      
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CREATING A LETTER 
 
Using the skills you have learned in this course so far, you can produce a simple 
letter. 

 Open a new document 

 Type the following text: 
 

 
 

Apple Cottage 
123 Field Head Lane 
CANTERBURY 
CT3 9RG 
 
 
7 January 2008 
 
 
Silverdale Plumbing Services 
7 Beedle Street 
CANTERBURY 
CT1 6BR 
 
 
Dear Sir 
 
REF: BATHROOM FITTING  [type heading in bold text] 
 
Thank you for your recent quote for refitting my bathroom.  I accept your figure of 
£800 + VAT for fitting only. 
 
As I have seen the bathroom suite that I would like, I will order it from the suppliers 
and inform you of the delivery date so that we can arrange a mutually convenient 
time for installation. 
 
Yours faithfully 
 
 
 
 
L G Mapley (Ms) 

 
 

 
 

 Save the document giving it the name Silverdale Acceptance Letter 

 Print the letter 
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PRINTING AN ENVELOPE 
 
Next you’ll print an envelope to go with the letter. 

 Highlight the address of the recipient 

 Click the Mailings tab on the Office Ribbon 

 

 

 

 
 

 In the Create commands group select Envelopes 
 
 
The Envelopes and Labels dialog box is displayed. 
 

 
 
The address you selected is automatically entered as the delivery address. 
 
A preview of the printed envelope is displayed.  You want to print the standard 
size ‘long’ envelope which is known as DL (110 x 220mm).   
 

Create 
commands 

Preview of how 
the printed 

envelope will 
look 

Correct position 
to place the 

envelope in the 
printer 
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To check the size of the envelope currently selected: 
 

 Click the Options button 

 Click the drop arrow to the right of the Envelope size box 
 

 
 
 

 Ensure that DL is selected 
 
Although the Envelopes and Labels dialog box indicates how you should feed the 
envelope into the printer, let’s just take a quick look at printing options. 
 

 Click the Printing Options tab 
 

 

This tells you 
whether to place 
the envelope face 
up or face down 

This shows you how to 
position the envelope 
so that it feeds into 
the printer correctly 
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The printer driver tells Word which way the envelope should be loaded into the 
printer and this information is displayed on the Printing Options tab.   

 Click OK 

 

Now, bearing that information in mind: 

 Feed an envelope into the printer (depending on the type of printer you 
have, there may be a drop-down tray at the front of the printer, or you might 
have to use the paper tray) 

 Click Print 
 

 Close the document without saving 
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OPENING A DOCUMENT 
 
Finally, you are going to open a document that already exists. 
 

 Click the Office Button 
 

 Select Open 
 
The Open dialog box is displayed. 
 

 
 

 Select the Mouse file by clicking on to it 
 

 Click Open 
 
The document is displayed on the screen. 
 
 
 
TO OPEN A DOCUMENT 
 
Press Ctrl and O 
 
 
 

 Make a small alteration to the text, resave it, and print it 

 Close the document 

 Close Word 


